Desktop Upgrade Initiative: Orientation
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Hardware Overview

CCSF staff spent much time and consideration on standards for new and baseline refurbished systems. 
Vendor

Competition among companies bidding for the new system was fierce. Eventually we came out with a company that satisfied our rigorous hardware standards, could support deploying as many machines as we needed, warranted good user support, and met requirements as a small local business. OmniPro has contracts with many colleges and school districts and with California cities and counties.

New system components: Desktop

	Component
	Desktop
	Laptop (will be updated)

	Case
	Midsize Tower (“on end”)
	Midsize Laptop: 8 lbs

	Processor
	Intel Pentium 4
	Intel Pentium III

	Processor speed
	1.7 GHz
	900 MHz

	Hard disk
	20 Gigabytes (GB)
	20 Gigabytes (GB)

	Internal Memory (RAM)
	512 Megabytes (MB)
	256 Megabytes (MB)

	Removable disk drives:
	3-1/2” 1.44 floppy 

250 MB Zip 

(also reads and writes 100 MB Zip disks

CD-ROM
	3-1/2” 1.44 floppy, internal

250 MB Zip, USB External

(also reads and writes 100 MB Zip disks)

CD-ROM

	Video Memory
	32 Megabytes
	16 Megabytes

	Monitor
	15” LCD (Flat panel) display
	14” LCD (Flat panel) display

	Pointing Device
	Optical Mouse
	Touchpad

	Other
	USB 2.0 ports

Sound Card and internal speaker

1 parallel and 1 serial port

Plugs for microphone, speakers or headphones

Keyboard
	To be determined


Your Software

The software on your new computer consists of:

1. Windows XP: 

· The newest Microsoft operating system

· New graphic look; easier to accomplish tasks like organizing files and folders

2. Office XP Suite containing 

· Word 2002: Document processing

· Excel 2002: Spreadsheets

· PowerPoint 2002: Presentations

· FrontPage 2002: Web creation

· Publisher 2002: Brochures, other light desktop publishing

· Access: Database
3. Microsoft’s Internet Explorer 6 Web browser

4. Banner (for those who need it)
5. Virtual Training Company (VTC) Reader: Direct access to online training modules

6. Anti-Virus software
· Protects against virus infection from downloaded or borrowed files and disks
7. Telnet and FTP: Software to upload Web pages to fog or cloud/www
Advantages of consistency

· Easier to get support. The Help desk and other tech support personnel will know everyone’s baseline load set of software.
Help desk: 239-3711 and http://www.ccsf.edu/Services/Help_Desk/
· Easier to exchange documents with other faculty and staff. Office XP opens documents created in older versions, whether created on the Mac or on a PC.

A Warning message
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When you open and start to save a document created in an older version of an Office program, you may see a screen similar to this one. This is not an error message:

· You can ignore this message (click Yes), or

· Click No and save the file as the new version…

· To convert a file to the newest program version:

1. On the Menu bar, click File ( Save As

2. At the bottom of the Save As screen, click the down-arrow to the right of the Save as type box, and go to the top choice (here it’s Word document)

Office XP for home

You may exchange data with an earlier version of one or more of the Office programs on your home computer. But you can now easily and cheaply eliminate this annoyance. You can get Office XP for home use under special terms negotiated by CCSF along with other California Community Colleges.
· To get the newest versions of Office for home use cheap (less than $55.00), get the special academic order form here: http://www.collegebuys.org/orderlist.asp
· Click the California Community College link for the order form.
GroupWare: The GroupWise program for email, calendaring

· Consistent Email

· Entire Faculty and Classified staff available from online directory 

· One-click access for address book, group entries

· Calendar and To-Do list features integrated with Email. Messages can suggest items to be added to calendars or task list upon recipient’s acceptance.

· Easy, fast Web access – from any computer with an Internet connection
Second stage

· Shared Calendars and Scheduling. Through sharing calendars, departments and committees can schedule meetings based on free-time searches. Individuals see an entry on their calendars immediately after accepting the proposed meeting time.
· Scheduling resources (rooms, equipment)

Adding New Software

· Your ITS Access and Support Tier determines whether you can add software 

· Be Careful! Follow all installation instructions.

· Check with the Technology Review Working Group before installing software that affects the network (e.g. chat, streaming media).

· Contact Robert Lam, TRWG chair, at rlam@ccsf.edu, before installing questionable software.
Software Piracy Warning

· When you log on, you may see a message reminding you of the need to install software in compliance with its licensing requirements.

· All software not specifically designated freeware must be legally:

· Purchased

· Licensed

· Installed in accordance with its licensing requirements
Your personal network space

A major goal of the Desktop Upgrade Initiative is to connect all campuses through the use of a network. You have a personal space on this network that you can use to save documents, pictures—anything you want.

Your My Documents folder actually lives on the CCSF network. Logging on to your CCSF computer, will automatically connect you to your 100 Megabyte space on the network server that has been set aside for you. Your network space holds 100 Megabytes (MB)—about as much space as 70 floppy disks. 
It is a private space. Only you can access the files and folders on this space. Your login and password protect this area from others. Of course, the network administrator has access to the entire network for backup.

You’ll also see your personal space in My Computer as drive H:. Some departments may also (by request) have another network space (Drive P: or S: in My Computer) that several department members can share.

Benefits

· Automatic Connection: When you log on to the CCSF network on your computer, your personal network space is available. 

· Automatic Back up: Network administrators will back your files up regularly.

· Mobility: When the network structure is fully implemented, you will be able to access your networked My Documents and its files from any Faculty or Staff computer.

Responsibilities

· Turn off or Log off your computer when out of your office to protect your documents.

· Pay attention to your storage space. Your My Documents network space is limited: when you reach 100 Megabytes, you can’t save any more stuff. To check available space, open My Computer, right-click your network drive and click Properties.

· Clean up My Documents by deleting/backing up parts of it as they fall out of use so that you don’t run out of space.

· If you regularly need to use more than 100 MB, you’ll have to save sections of your work somewhere else on your hard disk and back it up yourself. Use the other documents in the Managing Files and folders section of the Orientation Web site to guide you through organizing, moving and copying your folders and files.

Accessing your network space(s)

· Open My Documents: Then double-click to open documents (actually saved on the network) just as you would on your floppy, hard disk or Zip.

· Open a document from a program like Word or Excel by clicking File > Open. Then click the down-arrow to the right of the Look In: box to see locations. Click My Documents or another network drive icon that you may have to see its documents.

· Save a document from a program like Word or Excel by clicking File > Save or File > Save As. Then click the down-arrow to the right of the Look In: box to see locations. Click My Documents or any other network space that you may have to save there. 
Logging On

Login names/UserIDs

Your login name (also called your UserID) is the same as the name you used on the fog server. For most people, it is the first letter of your first name followed by up to 7 letters of your last name for a total of up to 8 letters. Some common names like Wong or Smith may have to use a middle initial as the second letter.

· For example,  Sharon Baumgartner’s login name/UserID would be sbaumgar
First time passwords

Your password for the first time login only is set to your birth date as recorded in the banner system in the form mmddyyyy. (Note that the year is 4 digits.)

· For example, a birth date of January 3, 1973 produces the password 01031973
Logging on for the first time

· When you first log on, use your login name and the supplied first time password.

· You may be asked to change your password immediately. 
You will be prompted to enter the new password twice.

Your new password

· Must be between 6 and 8 characters and contain at least 1 number and 2 letters.

· Case-sensitive: if you enter Capital letters and lower-case letters, you will have to do that every time. This is good practice, but—you have to remember!

Logging in after the first time

· Your computer screen displays a Welcome screen when you turn it on. This screen also appears when another user logs off or the computer logs you off after 20 minutes of inactivity. The Welcome message asks you to press Control-Alt-Delete.

· These keys (Ctrl-Alt-Del) are all at the bottom of the keyboard. You must press them all the same time, not in sequence. When you do, the login screen appears.

· Log on as usual with your login name and password.

Changing your password

· Every 180 days you will be asked to change your password. If you click Yes, the computer will ask you to enter your old and new passwords.

· To change your password at will, power up and log on. Then press the Ctrl-Alt-Del keys all at once. A window pops up. Click the Change Password button (lower left).

Forgotten passwords

If your login and password just aren’t working, contact the help desk at 239-3711 for assistance. They will be able to reset your password back to your Banner birth date.

Logging off vs. Powering down

You can Log off your computer instead of powering it off. Click the Start button; then click Log Off. The next person to use the computer can press Ctrl-Alt-Delete to log on.

Log off or power down a shared computer when you leave. If you don’t, you will lock the computer so that only you can unlock it and log on. The next user has to press the Reset button next to the power light or hold in the Power button until the computer shuts down.

Printing

CSF has developed a plan to make better use of printing resources. This document outlines some features of the plan, and then discusses how you can print.
Networked Printers

CCSF has new, networked, high-quality black-and-white laser printers. There are fewer personal, local printers (printers directly attached to individual computers), but more new printers that can be used by groups of people. These printers have been placed in consultation with department heads and supervisors so that they are reasonably convenient to access: on the same floor, in the same general area as your office.

Ask your local ITS staff person, or other users, about the printers in your area.

Printer Naming

No more printers named Bugs or Francine! Printer names indicate their location. So you’ll see printers with names like P-JAD323-HP2000:

· P for printer

· JAD for building (in this case, campus) location

· 323 for room

· HP2000 for maker/model

These conventions should be fairly obvious, and were set up to help you quickly find the closest printer to wherever you are when you print.
Special printers

In addition, there will be a few special networked printers available in central locations:

· Large format duplex printers (able to print on paper up to 11” x 17” and on both sides of the paper)

· Color laser printers

These will be purchased and set up over the next months for faculty and staff use.

Choosing a printer

The printer you will normally print to (your default printer) is preset on your computer. You may want to change your default printer (if it is offline for an extended period, say, or if there is another printer that’s more convenient for you).

Occasionally you will need to print to a printer other than your default—the special color printer in your area, for example. Or you may be using a computer at John Adams, and want to print to the printer nearest your next classroom on the Ocean campus. Those naming conventions come in handy here, since you’ll have a lot of printers to choose among.

Here’s how to change your default printer and how to print one time to a printer that isn’t the default set up on the computer you’re using (without disturbing the regular print destination for that computer).

Changing your usual printer
To change the printer you normally print to (your default printer) or to check on your printer, follow these steps:
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Click Start.

2. In the right Start menu column, click Printers and Faxes.
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The Printers window opens showing available printers on the right and tasks on the left. The default printer has a little black checkmark in the upper right area of its icon.

4. You may need to scroll down to see the printer you want.

5. Click to choose the printer you want to print to normally.

6. RIGHT-click the printer you want to change to.

7. From the popup menu, choose “Set as Default Printer.”

Changing the printer for one print job

When you don’t want to change the printer you normally print to, but need to send to a different printer, wait until you are about to print the document. Then, from inside the application (Word, say, or Excel):

1. From the menu bar, click File > Print

The Print window opens.

2. In the Printer area at the top left, click the down arrow to the right of the Name: box to see your choices.

3. Click the printer you want.

4. Set the number of copies and any other options; then click OK to send your job to that printer.

Windows XP Start menu and Taskbar

Shutting Down
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You still shut down using the Start button at the lower left of the screen. But now the shut down button is immediately above for you to click.

If you click Shut down, the next screen allows you to choose exactly the operation that you want. When the Shut Down Windows dialog appears, you can click the down-arrow at the right of the box to see your choices.

If you choose Log Off, the computer remains powered, but disconnects from the network. The Welcome screen appears. This is good security practice when you leave your computer and a courtesy to others using a shared computer—you will lock the computer if you don’t log off. Then, the next user will not be able to log on unless they press the Restart button.
Another screen may appear asking the next user to press Control-Alt-Delete to log on. 

( Note: You must depress the Ctrl, Alt and Del keys at the same time for them to work.
The Taskbar

The Taskbar is the strip at the bottom of your screen that contains the Start button. Many of the taskbar’s features repeat from Windows 95/98:

· Icons for all programs that you are running appear on the taskbar. 

· To restore a program to its last size when it is minimized, click its taskbar icon.

· To switch among several running programs, click the program’s taskbar icon.

· If you can’t make changes to your taskbar, it may be Locked. To Unlock, right-click an empty area of the Taskbar and click Lock the Taskbar to delete its checkmark.

The Quick Launch toolbar

By default, your rollout computer displays a Quick Launch toolbar at the left of the Taskbar. If it disappears, you can bring it back: 

1. Right-click an empty area of the taskbar and choose Toolbars ( Quick Launch or Properties ( Show Quick Launch.

2. To copy program icons to the Quick Launch toolbar, right-drag them from anywhere on the Start menu or desktop and choose Copy from the popup menu. 

New Taskbar Features
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When you start Word, its icon appears as usual on the taskbar. When you open several documents, however, the document icons collapse into one. A number shows how many documents you are working on. To shift among your open documents

1. Click the icon—it expands, showing document names.

2. Click the one you want to switch to it.

Start menu overview
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Open the Start menu by clicking the Start button. The Start menu serves the same functions as it did in Windows 95/98, and more.

Start Menu: Left Column

The Start menu’s left column is divided into three sections 

· The top section contains Pinned program icons. These remain stable. 
To add a program to this area, click All Programs, right-click the program’s entry, and choose Pin to Start Menu. 
To remove a program from this area, right-click and choose Remove from this list.
· The middle section, above All Programs, contains the icons of the last programs you have used. The list changes dynamically as you use different programs.
· The All Programs button at the bottom opens cascading menus that contain all programs and program groups on your computer.
Start Menu: Right Column

The Right column offers quick access to important computer locations and resources. 

· The top area allows you to open the My Computer or My Documents windows, or to get back to one of the documents you’ve edited most recently.

· The Control Panel allows you to control many aspects of your computer, from the way your opening screen looks to the date and time zone. 

· The Printers area allows you to set which printer you’d prefer to print to regularly and to control print options.
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Look up any Windows feature in Help and Support

· Click Search to find a document by name or by any phrase it contains.

Desktop icons

Part of the new look for Windows XP is a clean desktop with very few icons. You can do with fewer icons because of some of Windows XP’s features:

· You can pin a program icon to the top of the Start Menu: 
Right click a Start Menu entry and choose Pin to Start Menu. 

Or: 
· You can Right-drag the program’s start menu entry to your Quick Launch toolbar and click Copy on the popup menu.

If you want, however, you can still add desktop icons to your heart’s content:

1. Click the Start button to open the Start Menu

2. Click the All Programs button and navigate through the cascading menus until you find the entry for the program you want to place on your desktop.

3. Right-click the program entry. A popup menu appears.

4. On the popup menu, click to choose Send to ( Desktop (create shortcut)
5. A Desktop icon for the program appears. The program entry also remains in the Start Menu structure.

6. Double-click the icon to start the program. 
Windows XP: Managing files and folders

Windows XP provides two convenient entry points into your disks, files, and folders: the links to My Computer and My Documents on the Start menu, and icons on the desktop and Quick Launch toolbar (beside the Start button).

My Computer
· To see the contents of a disk or a Network drive: 
· Click the Start button, move the cursor to the top right, and click My Computer.
Or double-click the My Computer desktop or Quick Launch icon.

· Then double-click the icon for your disk: floppy (A:), Zip (E:), network space (H:), or hard disk (C: or D:). 
My Documents
My Documents is the folder where Word and other Office applications will automatically save your documents. On your new rollout systems, it actually lives on the CCSF network, where system administrators back it up regularly. To open My Documents: Click the Start button, move to the top right, and click My Documents. 

The My Documents / My Computer display

My Computer and My Documents display a menu and icon bar above left and right panes.

Icon bar buttons
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Use the icon bar to navigate quickly, to search, or to change the way items appear on the right. 

· With one click, the Folders icon shifts the left pane between its two views: Tasks view, which allows quick selection of common tasks, and Folders view, the clickable tree-style view of all the disks and other resources on your computer.

· Back and Forward take you to the previous and next places you visited as you navigate through a disk (like the similarly marked buttons in a browser).

· Up takes you one level up from where you are: to the folder or disk that holds the folder you’re in, or back to My Computer or the Desktop.

· Search starts off finding a document or folder (it’s also on the Start menu).

· Views changes the way items appear in the right pane. 

The Left Pane

The Left pane displays either Folders view or Tasks view (shift by clicking Folders icon).
Tasks view (the default) is best for: 

· Quick access to operations relevant to what you are viewing on the right

· Moving or copying files and folders

· Performing tasks tailored to specific file types (like pictures, sounds, video).

The Other Places group suggests other areas you might want to display.

The Right Pane

The Right pane displays the contents of your computer, or a selected disk or folder. 
In the right pane you can:

· Arrange the order and look of your file and folder display

· Double-click disks or folders to view contents and double-click to open documents 

· Create new folders

· Select files and/or folders to perform common tasks: move, copy delete or rename

Viewing the contents of disks and folders

Disks are organized by making folders and putting stuff into them. 

A folder is just a container. It can hold two things: files and other folders. 

A file is any document saved on a disk.
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Often folders are nested several layers deep. To navigate these layers, double-click a folder icon to see its contents. In this way you can dig down from one layer to another.

To move back up one level to the folder or disk that contains the folder you’re in, use the Up button on the icon bar. To move back to your last location, click the Back button.
Opening documents from My Documents or My Computer

Most documents are connected with a program on your computer. When you double-click the document in the right pane of the My Documents or My Computer display, it opens inside its program, ready to work on. Simple!

Changing Views in the Right Pane

The View menu in My Computer / My Documents has new options in Windows XP. These options and their results vary according to what you are looking at.

Thumbnails: Shows small images of pictures and some other file types. 

Tiles: Large, easy to click icons. 

Icons: Smaller icons. 

List: Smallest icons to get more on the screen at once.
Details: Shows size, type, date modified as well as name. 
Filmstrip: Great for (and only available with) pictures. Shows one large image at top, with a strip of images at the bottom to scroll through using VCR-like Previous/Next arrow icons: An instant slide show!

Arrange by… and Show in Groups
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Using the Arrange by options in the View menu (not the Views pulldown on the icon bar). helps logically organize the display of your files.
Recommended: Arrange Icons by Type and Show in Groups.

If you choose Arrange Icons by Type along with Show in Groups, Windows arranges by document (Word, Excel, PowerPoint) or picture (jpg, gif, etc.) type. Speeds up finding what you want.

Organizing My Documents

Set up My Documents with folders named so that you can save documents efficiently and find what you want quickly. Organizing on disk is like organizing paper:

· Make folders and label them

· Put files and other folders into your folders in a logical manner

Creating Folders
1. Open My Documents or My Computer and go to the folder you want to organize.

2. If you don’t see a listing of tasks (the blue Task Pane) on the left, click the Folders icon above the right pane.
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Look at the Task pane on the left. The top section lists tasks that vary according to what you’ve selected on the right.
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In the left (task) pane, click Make a new folder.

A New folder icon appears in the right pane with its name, New Folder, highlighted. 

Immediately type the name of the folder—what you type replaces New Folder.

Folders inside folders
Create folders inside folders when you are organizing yourself. Double-click the folder inside which you want to make new folders. Then make new folders there. 

Copying, Moving and Deleting files and folders

1. In the right pane, click a file or folder to select it.
To select several at once, hold down the Control key while you click other files and folders. (If you select the wrong one, just Control-click it again to de-select it.)

2. When you have selected the files and folders to Move, Copy, or Delete, click an action in the left (Task) pane. 
(Tips: Don’t choose Publish this file to the Web unless you like using Microsoft’s Web services. Our new CCSF email may not work with the 
E-Mail this file choice.
3. When you Delete, you must confirm moving the selected items to the Recycle bin.

When you Move or Copy, the Move or Copy window opens.

4. In the Move or Copy window, click the destination disk or folder and click the Move or Copy button. Your selected items are immediately moved or copied there.

· Click the Make New Folder button to organize on the fly. Make sure that you’ve highlighted the folder inside which you want to create the new folder. 
Then you can move or copy directly into the newly created folder.

Navigating through folders

As you organize, you’ll make many folders inside other folders. To move or copy a document to a folder that you’ve nested inside other folders, you must navigate to it. 
Navigating is simple: click any folder with a plus sign to see folders inside it.
In Figure 1 we’ve clicked the Admin folder to open it. The 33Gough2001 folder contains other folders. Figure 2 shows part of the display when we click 33Gough2001 and then select hirings. The selected folder is where you’ll send the files you move or copy.

The Recycle bin

When you delete anything, it goes to the Recycle bin. Since the items in the recycle bin take up space on your disk, you should empty the recycle bin every so often.

Emptying the Recycle bin
1. Double-click its icon

2. On the Task Pane (left), click Empty Recycle Bin
Restoring an item

1. Double-click the Recycle bin’s icon to open the Recycle bin.

2. Click to select one item or control-click to select several.

3. On the Task Pane (left), click Restore. The items get put back where they were.

(Tip: The fastest way to copy to your Zip or Floppy

1. Navigate to My Documents or your Network drive. 
2. In the right pane, select what you want to Back up to a floppy or Zip.
3. Right Click. 

4. In the Shortcut menu, select Send To:
5. Your Send to: choices include your Floppy and Zip drives. 
Click whichever you want.
Backing up and Offloading files and folders

· Why Back up? Be safe: always keep more than one copy of important documents.

· Why offload? Your My Documents Network storage space is limited to 100 megabytes: you may need to clear space for new work.

· All those old documents make it hard to find what you need NOW.

How to do it: In My Computer or My Documents navigate to where your files live. Select them or their folder in the right pane. Move or copy them to another disk.

City College Help, Support and Training

Technology Learning Center (TLC) open lab

The TLC’s open lab in 313 Batmale Hall on the Ocean Campus has PCs and Macs, printers and scanners for all faculty and staff. Hours: Mon-Thurs 9–6; Fri 9– 4:30.

The TLC Desktop Upgrade Web site

A Web site supporting the Desktop Upgrade is available as a link from http://www.ccsf.edu/tlc/
Pages in the Orientation section of the Desktop site mirror the Orientation modules, with topic summaries, PowerPoint modules covering all Orientation topics and additional information to download and print.

Help desk

CCSF’s Help Desk for Faculty and Staff computer users is available at 415-239-3711.

The Help desk deals with CCSF office computer and printer problems, logging on and password concerns, and questions about programs on CCSF’s Supported Software list. 

Hours (regular semester): Mon – Fri 9-4:30.

The Help Desk Web site

The Help Desk site, at http://www.ccsf.edu/helpdesk/ is also available as a link from the main TLC site: http://www.ccsf.edu/tlc. The site contains:

· Information on checking out a digital camera, laptop computer, or projector: http://www.ccsf.edu/Services/Help_Desk/html/equipment__check_out.html
· Links to sites and documents with helpful information and tutorials

· Link to Forms for CCSF resources and for buying software at special prices: http://www.ccsf.edu/Services/Help_Desk/html/forms.html
Help Desk Appointments

Call the Help Desk to schedule half-hour appointments for in-person help in the office at 310 Batmale Hall on the Ocean Campus or in the TLC computer lab, 313 Batmale Hall. Even without an appointment, student lab aides may be available for shorter sessions.
VTC Online training

Your new software includes an online training player connected to many high-quality pre-recorded training modules on topics including Windows XP, all Office 2002 Programs, Adobe PhotoShop. To open the VTC Viewer click Start > All Programs > VTCPlay.exe. Click the left menu for topic areas and the right menu for specific modules.

· VTC Player may not work if you are a level 1 user.

Windows Help and Support Center

An expanded Windows Help system is available from the Start menu. To start Help:

1. Click the Start Button. Then on the right pane, click Help and Support. 

2. To use the Search box at the top: Enter a term and click the right arrow to search. 

3. On the left, you can search for Windows XP help by clicking a topic menu. 









These pages summarize the Desktop Upgrade Initiative User Orientation. Individual sections of this document are available online in the Desktop Upgrade pages off the Technology Learning Center Web site: � HYPERLINK "http://www.ccsf.edu/tlc" ��http://www.ccsf.edu/tlc� 


In addition, the Desktop Upgrade Web pages will contain:


Goals of the Desktop Upgrade Initiative (DUI)


Procedures and documents used for the deployment of CCSF computers during the Initiative


A Frequently Asked Questions (FAQ) page that grew out of meetings with Faculty and Staff. It will be regularly updated.


Links to Powerpoint presentations used in User Orientations for online viewing or downloading


Outlines of additional DUI Level II and Print Manager Training


Further Information about the Orientation’s topic areas
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